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The following icons are used in this user manual:

The information icon precedes important information.

& | The example icon indicates a practical illustration of a process or procedure.

The hint icon indicates a suggestion or hint to guide or assist you with performing a
task.

v | The warning icon provides a warning against potential mistakes and actions that could
~ | cause critical error.
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Congratulations on choosing Attix5 Pro Desktop & Laptop Edition. Attix5 Pro minimises risk,
maximises productivity and allows businesses to regain control of their most valuable asset -
their data.

For technical support, please go toAttix5 Pro > About Attix5 Pro , and then use the contact
details provided.

With Attix5 Pro Desktop & Laptop Edition (DL ), data stored on desktop and laptop computers
can be backed up to a Storage Platfornrquickly, securely and automatically.

The following diagram illustrates the scenario:

Files and folders stored on desktop or lapto p

Storage Platform

computers running Attix5 Pro DL can be
backed up to a Storage Platform . In the event
of data loss or corruption, you can retrieve
data from the Storage Platform and restore it
to the original or another computer in just a
few easy steps.

A Backup Administrator can manage the
entire backup environment ( DL Clients and the Storage Platform) remotely, using the Attix5 Pro
Storage Platform Console For more information, please refer to the Attix5 Pro Storage
Platform Console User Manual
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1. Getting s tarted

Enabling manual or automatic backups is easy with Attix5 Pro Desktop & Laptop Edition :

BACK UP
Automaticallyor
manually

Create a Backup Select files and
=tall DL Account folders for backup

(See page 13) (See page 32) (See pages 4244)

(See page 7)

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved. n
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Below are the systemrequirements for Attix5 Pro Desktop & Laptop Edition .

i) For the latest system requirements and compatibility information, please refer to
the Requirements-Compatibility.pdf (provided with each release of the Attix5 Pr o
software).

DL is available for the following Macintosh operating systems:
MAC OS X 10.5 (Leopard)
MAC OS X 10.6 (Snow Leopard)
MAC OS X 10.7 (Lion)

i) Java is not included with installations of Lion. For Attix5 Pro V6 to function as
intended, Java must be installed before Attix5 Pro V6. For more information, please refer
to the Attix5 Pro V6 FAQ:

Required: PowerPC G3 G4 or GYIntel Core processor with 128 MB memory above
operating system requirements.
Recommended: 512MB above operating system requirements.

Required :50 MB plus space for local cache

i) Please ensure thatthe drive on which the Backup Client will be installed has
enough free space to storecopies of the selected files.

Recommended: Amount of free space equal to the Backup Account limit . The local
cachecan be as large as the total size of all file$ncluded in the backup selection.

= A file inclusion of 100 MB needs up to 100 MB extra disk space for the
cache.

Minimum video requirements: 800 x 600 Resolution, 256 colours


http://v6.attix5.com/kb/?View=entry&EntryID=70
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The DL DMG file contains pre-configured information to make installing DL quick and easy.

i The options available during the installation process depend on the settings
enabled by the administrator when the DMG file was created. These options range from
advanced install settings to specifying the install location.

v\ | Pre-installation  warnings

A If running antivirus software , please ensure that all Attix5 Pro folders are excluded
from being scanned to avoid data corruption.

A Both antivirus software scans and backup processes are resourceintensive. It is
advised not to run a backup and virus scan at the same time as this will
significantly dec rease machine performance.

A Java is not included with installations of MAC OS X 10.7 For Attix5 Pro V6 to
function as intended, Java must be installed before Attix5 Pro V6.

To install Attix5 Pro DL:

1. Run the DMG file.
2. Run the PKG file.
3. Inthe Attix5 Pro Installer that appears, follow the steps to completion. See below.
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Attix5 Pro Installer
The Attix5 Pro Installer typically consists of four stepsto guide you through the installation in a
simple, step-by-step manner. These steps also make it possible to undo previous operations by

navigating backward.

ly Note: Some of the settings encountered in the installer may have been removed when
the DMG was created. Furthermore, the installer may contain additional step s. Please
read each window carefully before continuing.

Step 1 of 4: Welcome

The Welcome page will outline the task to be performed.

To start the installer :

Click Continue

LN O « Install Attix5 Pro

Welcome to the Attix5 Pro Installer

© Introduction

You will be guided through the steps necessary to
install this software.

® Destination Sele¥y
) lnsiaiiavorx‘l’ypej

® Installatign

i

® Summaty s

Go Back [ Continue )

N
NS
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Step 2 of 4: Select an install destination

To select a destination forthe DL application files and folders:

1. Select the disk on which you wish to install DL.
2. Click Continue .

O Introduction
© Destination Se

P

Em\ml\l“‘\.'"

Select a Destination

Select the disk where you want to install the Attix5 Pro
software.

‘Macintosh HD
98,07 GB free
119,69 GB total

‘ Instaliing this software requires 26,9 MB of space.

( GoBack ) ( Continue ) J

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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Step 3 of 4: Install

To begin the DL installation

Click Install

v

Tip: Should you wish to change the install location, you can use the Change Install
Location button.

i) | Note: At this point, you may be prompted to provide a password to allow the installer
to make the required changes to the operating system. Supply your Mac username and
password in the boxes provided, and then click OK..

N0 '« Install Attix5 Pro
Standard Install on “Macintosh HD"
& Introduction
& Destination Sel This will take 26,9 MB of space on your computer.
L= |“5tﬂ“ﬂti'ﬂJT¥' : Click Install to perform a standard installation of
& Installatilh 4 this software on the disk "Macintosh HD".
5
® Summ afy Y
o _-|l'-]|'""|""'|l"”-"
T L W a 5
by 1

f: Change Install Location... :"

I’; Go Back :' I'\: Install :'

i

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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Step 4 of 4: Close the installer

To close the installer
Click Close.

aNO « Install Attix5 Pro

The installation was completed successfully.

O Introduction
© Destination Sel
e Installation(:Ty_

© Installation
a

© Summary The installation was successful.

i
.I"\‘”"I““\\‘

T =i The software was installed.

W

After clicking Close, Attix5 Pro DL will be installed on the machine.

i) | Note: After an auto update from a version prior to 6.2 to version 6.2, you will be asked
to enter the Mac system password the next time you launch Attix5 Pro. The auto update
process cannot be completed unless you supply the system password.

8006 Enter password
Please enter your system password to finish the auto update process.)

' J

( 0K ) (Cancel)

2|

Upon opening the DL Client for the first time, the Backup Account Setup Wizard  will
launch, enabling you to create a Backup Account. Follow the wizard steps as describedin

Y

Chapter 3, AAccount setup.o

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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To be able to backup or restore data using the Backup Client, a Backup Accountis required.

The Account Setup Wizard will launch when the Backup Client is opened for the first time (for

more information, see Opening the Backup Clienti n Chapter 4, AGr a&phical User
i) To run the Account Setup Wizard at any other time : On the Tools menu, click
Account Setup Wizard . In the warning box that appears, click the Run Account

Setup Wizard button and follow the instructions below from Step 2 onwards .
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The Account Setup Wizard typically consists of sevenstepsto guide you through the Setup task
in a simple, step-by-step manner. These steps also make it possible to undo previous operations
by navigating backward.

i) Some of the settings encountered in the wizard may have been removed when the
Installation DMG was created. Furthermore, the wizard may contain additional step s.
Please read eachwindow carefully before continuing.
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i) This step displays when the wizard is run directly after the DL Client installation.
If accessing the wizard at a later stage ( via the Tools menu), this step will not display as
the Storage Platform settings will already have been configured.

To specify the Storage Platform connection settings

1. In the Storage Platform address box, type the IP address or DNS name of the
Storage Platform where the Backup Accountresides.

2. In the Group name field, specify
which Backup Group the Account
belongs to.

3. In the Group create key field, specify the preconfigured Group create key for the
applicable Group. If you do not have access to this key, please contact your Storage
Platform administrator.

i) This key is case sensitive.
4. Once all the correct settings have been entered, clickNext .

.00 Account Setup Wizard

Enter the Storage Platform connection settings. r @
Please contact your backup administrator if you do not have the required information. Ll

Storage Platform Settings

Storage Platform address: | 192.168.20.215

Group name: A-5P OWNER\RESELLER A\BACKUP ACCOUNTS

Group create key: en

ATTIX’Pro

{ B | o f B |
( Help ] = Back | Cancel )
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This wizard step is typically the first to be displayed if you access the wizard via

the Tools menu.

You can selectl want to connect to an existing Backup Account to:
Connect to an Account that has been opened for use by this computer.
Reconnect to an Account to recover data from the computer that had
previously backed up to this Account.

To create a new Backup Account

1. Selectl want to create anew  Backup Account
2. Click Next .

To connect to an existing account:
1. Selectl want to connect to an existing Backup Account

L Warning: Different users cannot back up to the same Backup Account.
A separate Backup Account needs to be created for eachuser.

2. Click Next to continue.

8.0 Account Setup Wizard
Specify the account type. ] @
Choose between a new or existing Backup Account. You cannot connect to the same Backup Account from different machines. [L

Account Type

Please select one of the following:
@ Iwant to create a new Backup Account.

O I want to connect to an existing Backup Account

ATTIX’Pro

!/ Help ) :/cBack ] (NE'Xt>\ !/Caru:el

A
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Step 3 of 7: Specify A ccount details

When connecting to an existing Account:

1. Inthe Backup Account name box, type the Account name.
2. Inthe Account password box, type the Backup Accountpassword.
3. In the Encryption key  box, type the encryption key chosen when the Backup Account

was created.
O Account Setup Wizard
Enter the new account details. F ]
Choose and enter your preferred account name, password and encryption key. r u ! @

~ Account Details

Backup Account name: | BACKUP ACCOUNT 01

Account password: ssssee

Minimum 4 characters

Confirm password: sessss

Please choose an encryption key of 8 characters or more that will be used to encrypt your backups on the server. Note: If you lose
this key you will not be able to restore your data, so write it down and store it somewhere safe.

Encryption key: sesssses

Minimum 8 characters

Confirm key: [--""" ]

ATTIX®Pro

Cree ) (o) @9 (ol )

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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To specify the new  Account details:

1.

/N
L

In the Backup Account name

box, type an Account name that

consists of a minimum of 4

characters.

In the Account password box, type a password that consists of a minimum of 4
characters.

In the Confirm password box, repeat the Account password entered in the Account
password box above.

In the Encryption key  box, type an encryption key that consists of a minimum of 8
characters.

Click Next .

Warning : Disaster recovery is not possible without the encryption key. Please ensure
that this key is kept in a safe place. THE ENCRYPTION KEY IS NOT STORED ON THE
STORAGE PLATFORM AND CANNOT BE RECOVERED OR RESET IF LOST.

fanOm Account Setup Wizard

Enter the existing account details.

Supply the Backup Account details that you want to reconnect to. [@

Account Details

Backup Account name:  BACKUP ACCOUNT 01

Account password:  esssss

Encryptionkey: [ qeennes

ATTIX’Pro

!/ Help ) :/cBack ] I(Next>\ !/Caru:el )

A
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Step 4 of 7. Specify connection settings

To specify the connection  settings :

1. In the Connection Settings area, selectl use broadband or another permanent
network connection

2. Click the Configure Proxy  button.

3. Inthe Proxy Setup dialog box that appears, select a proxy type.

4. If Use SOCKSvV5 Proxy or Use HTTP Proxy is selected, fill in the Proxy Host and
Proxy Port boxes.

5. If login details are required, select the Proxy server requires authentication check
box and type the username and passwordin the boxes provided.

6. Click OK to close theProxy Setup dialog box.

7. Click Next to move to the next step in the wizard.

anNon Account Setup Wizard

T Stat ey of crmction oo ottt it [_[L@

/

Connection Settings
I use a modemy/dialup connection.
@ T use broadband or another permanent network connection

( : y
| Configure Proxy |

ATTIX’Pro

( Help ) ( <Back ) (Nent>) (" cancel )
A
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Attix5 Pro can run backups on included files and folders either upon request (manually) or
automatically. This step enables you to set up a backup schedule.

It is advised to back up at night when the machine is running and the Backup Client
is not in use. The machine must be switched on at the time(s) specified for scheduled
backups, but the Mac user doesnot needto be logged in.

To configure the Backup Client to run only manual backups:
1. Clear theDaily automatic bac  kups check box
2. Click Next to move to the next step in the wizard.

t. | Warning:  This option is not recommended. If an automated backup scheduleis not
created, backups will have to be run manually . Enabling automatic backups is
strongly advised .

To schedule daily automatic backups

1. Select theDaily automatic backups check box
2. Inthe Back up every day at  box, specify a backup time.
3. Click Next to move to the next step in the wizard or schedule additional advanced

backups as described below.

aNeO Account Setup Wizard
Do you want to schedule automated backups? @
Specify the daily and hourly backup schedule. You are strongly rec to enable aut: tic backups. L !

Automatic Backups

[W! Daily automatic backups
Back up every day at: ﬂ 19h 00 @
|| Advanced Schedule
Back up at the following times
Week Day Additional Schedule

Backup time:

= 12

(Y]

ATTIX’Pro

Help | [ =Back \: (Nent> ) :/ Cancel \:
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To schedule advanced backups:

1. Selectthe Advanced Schedule check box.

In the Week Dayarea, selecta day on which a backup should be initiated.

Specify the time in the Backup time  box.

Click the Add button to add the day and time to the Additional Schedule  box.
Repeat the steps above until you have added al desired schedules to theAdditional
Schedule box.

6. Click Next to move to the next step in the wizard.

a b N

- YeYe) - - - : Account Setup Wizard

Do you want to schedul t ted back ? r @
Specify the daily and hourly backup schedule. You are strongly rec to enable ic backups. ‘ |

Automatic Backups

E Daily automatic backups

Back up every day at: :I 19h 00 @
[ Advanced Schedule
Back up at the following times
Week Day Additional Schedule
[Monday | Backup time: Sunday@12h00

Tuesday = 12n00 @ Saturday@12h00
Wednesday

Thursday

Friday
Saturday Delete

[— <+

ATTIX’Pro

( Help ) ( <Back ) (Nent>) (" cancel )

)
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Step 6 of 7: Specify working folder locations

Under normal circumstances, the default Temp , Cache, Logs and Database folder locations

can be accepted andyou can click Next without making any modifications. If, however, the

drive on which the Backup Client is installed has limited space available, you can move the
folders and selection databaseto another location.

/1, | Warning:  Please ensure that these folders are located on a drive with sufficient free
space.

To change the temp , cache, logs and/or database  folder locations:

1. Click the Browse button next to the appropriate box (e.g. Temp ), and then select a
different location for that folder.

2. Repeat step 1 above until all folder locations are correctly specified.

3. Click Next to continue with the installation process.

/1, | Warning:  The Cache and Temp folders must reside on the same drive/volume.

.00 Account Setup Wizard

Do you want to modify the default working folders?
You can move the Cache, Log, Temporary folders and the Selection Database to another location if there is limited space available on the drive where .
the Backup Client is installed. ‘ |
Working Folders
Note: Always keep these folders on the same drive/volume. If the Cache and Temp folders are placed on different drives it will hamper perform...

Temp: [Applications/Attix5 Pro.app/Contents/Resources/toBackup '/ Browse... \
Cache: [Applications/Attix5 Pro.app/Contents/Resources/cache '/ Browse... \
Logs: [Applications/Attix5 Pro.app/Contents/Resources/logs '/ Browse... \
Database: [Applications/Attix5 Pro.app/Contents/Resources '/ Browse... \

/

ATTIX’Pro

( help ) ( <Back ) (Nent>) (" cancel )
A
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In the final step of the Account Setup Wizard, a Summary screen displays a list of the configured
settings.

To confirm the Setup information:

1. Read and verify that the information is correct, and then click Next .
2. The Backup Client will connect to the Storage Platform and configure the Backup

Account. A message will be displayed to confirm that the Account was set up
successfully.

3. Click OK to close the message box.

aNeO Account Setup Wizard
Confirm your account settings. @
If the settings below are correct then click Mext, otherwise click Back to change your settings. E !
Summary

You have entered the following information:

Attix5 Pro Username: BACKUP ACCOUNT 01
Connection method:  Local Area Network
Automatic backups:

Backup daily at: 19h00

ATTIX’Pro

:/ Help \: :/ < Back \: ( Next = ) :/ Cancel \:

A

Now that a Backup Account has been configured/you have connected to an Account on the
Storage Platform, you can select the files and folders you wish to back up.
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You can use the Graphical User Interface (GUI) to:

Select files for backup

Launch backups

Schedule automatic backups

Find files in previous backups

Restore files and folders from previous backups

To open the DL Client interface
Click the Attix5 Pro icon in the Dock.

The first time you open the Backup Client, the Account SetupWizard launches
automatically . For more information on creating a Backup Account,seeChapt er 3,
setup. o
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The Client interface

explained

You canmanage and monitor backups using the Backup Clientapplication window .

Application window

The Backup Client application window contains the following areas:

® Attix5 Pro  File

View Help -

ol@

Badup Soe

Automate

@@

| &l Restore

i@ My Computer

¥ |27 My documents
b me

[ ssh

| Trash

= Xcode

| AttixSLogs

| Desktop

= dev

| Documents

| Downloads

| Library

L= Movies

L7 Music

L Pictures

L7 Public

| Restore

| Sites

L= tmp

| utils

Y Y Y Y Y Y Y YYYYYVYYYYYYY

usr

Wixivivivivivisiviivivviviviviviviviviyg

|7 woWidgets-2.9.0

Filename /4

fseventsd

Spatlight-V100

Trashes
~ol

Applications

bin

cores
dev

Develaper
hannes
home
hudson
Library
net
Netwark
private

shin
sw

System

Users

mes

DS_Store
file
hotfiles btree

mach_kernel

Ready

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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‘You can tell the Backup Client which files
and/or folders to back up and which to
ignare by clicking the 8 Backup
Selection tab and then i

excluding the items as ibed below.

Tip: Once a file or folder is included in the
backup selection, any madifications to it will
be backed up automatically.

Include an individual fil
Include an entirg T
Exclude or subfolder
e the backup selection size

To include an individual file:

In the Backup Selection tree, navigate to the
folder or directory containing the file. In the
right-hand pane, dlick the file icon (O} or
point to the file name and Contral-click, and
then click Include. An included file is
displayed with a green icon: ©,

To deselect a file, you can either click the
ican again or paint to the file name and
Control-click, and then click Deselect. A
folder containing some included files is
displayed with a green tinted icon: .

Menu bar

Toolbar

Tabs
___— Product Help

Status bar
_—
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Menu bar and toolbar buttons

All Backup Client functions can be performed from the menu bar. Shortcuts to the most
commonly used menu bar functions are also available on the toolbar and shortcut (Control -
click) menus.

Menu bar

Each menu on the menu bar contains one or more options. The tables below describe the
Attix5 Pro options available.

Attix5 Pro menu

About Attix5 Pro Access the product information and support contact details.
Preferences Opens the Options and Settings  dialog box that enables you to modify a
range of Client settings. For more i

Settings. o

Hide Attix5 Pro Hides the Attix5 Pro application window .

i) Note: This will not stop the Attixs Pro service from running

scheduled backups.

Quit Attix5 Pro Closes the Attix5 Pro application.

File menu

Backup Now Initiate a Backup immediately.

Restore Switch to the Restore view in the Client.

\j Tip: For faster access to the Restore view, click the Restore tab
instead of using the File menu.

Calculate Size Determine the total size of the dataincluded in the backup selection. For more
information, see Determining the backup selection size in Chapter 5,
iBackups. o

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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File menu continued...

Find Files in Backups

Export Selection

Access theFind Files in Backups  dialog box. This box enables you to
search for particular files in your backups. For more information, see
Finding files in backups in Chapt:

Export a list of all backup inclusions and exclusions to an html file for
future reference. For more information, see Exporting a selection report

in Chapter 5, fiBackups. o

Tools menu

Automatic Backups

Account Setup Wizard

Remote Management

Health Check

Snapshot > Export
Backup Snapshot

Access the Backup Schedule settings in théptions and Settings

dialog box. Configure the settings in the Automatic Backups area to set

up one or more automatic backups. For more information, see

Scheluling automatic backupsi n Chapter 5, f@ABack:!

Launch the Account Setup Wizard, which enables you to change the
Backup Account settings. For more information, see Account Setup

N

Wizard inChapt er 3, AAccount setup. o

Access theRemote Management  Settings dialog box. Using the
settings available, you can enableRemote Management of the Client via
the SP Console. For more information, seseRemote Management in
Chapter 8, fAOptédons and Settings.

Access theHealth Check dialog box. Performing a Health Check
enables you tohighlight possible issues. For more information, see
Health Checki n Chapter 8, AO@tions and

Accessthe Export Backup Snapshot  dialog box, which enables you to
configure the next backup to be a Snapshot backupto a specific location.
For more information, see Backup Snapshotsi n Chapter 8,
Settings.0

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.



ATTIX®

Tools menu continued...

Click the option to...

Snapshot > Import Restore Accessthe Import  Backup Snapshot dialog box, which enables
Snapshot you to configure Restore Snapshot settings For more information,
seeRestore Snapshotsi n Chapter 8, AO@Pti ons

View menu

Click the option to...

Language > Access the GUIllanguage options available.
[ English/German/Default ]

Help menu

Click the option to...

Icon Legend Access a list of the cons used in the Attix5 Pro Client and the statuses
they indicate.

Product Help Access the ProductHelp.

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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[ 7 Backup Selection ] Restore =| Logs '

& My Computer I Filename /&% Size Date
|~ My documents | fseventsd 2010-01-2...
= me | | L= spotlight-v100 2009-01-1...
— || | |~ .Trashes 2009-09-0...
LS ssh [ | 7 ol 2000-05-1...

There are three tabs availablein the Backup Client:
Backup Selection : This tab displays the files and folders on the computer, enabling
you to select the items to be backed up For more information , see Selecting data to
backupi n Chapter 5, fABackups. o
Restore: Use this tab to browse previous backups and restore files and folders.
Logs: Use this tab to view detailed information on each backup and restore.

When the Backup Selection and Restore tabs are selected you can click any of
the column headings in the right -hand pane to sort the contents accordingly .
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Product Help

@ You can acess theBackup Client Help by clicking Product Help  on the Help menu.

o Alternatively, click the Help button on the toolbar.
elp

As you navigate the Client, the Help pane will display information relevant to the selectedtab.

&4 Product Help

You can tell the Backup Client which files
andyor folders to back up a nd which to

ignore by clicking the H Backup
Selection tab and then including or
excluding the items as described below.

Tip: Once a file or folder is included in
the backup selection, any modifications
to it will be backed up automatically.

How to...

Include an individual file

Include an entire folder

Exclude a file or subfolder
Calculate the backup selecticn size

To include an individual file:

In the Backup Selection tree, navigate to
the folder or directory containing the
file. In the right-hand pane, click the file
icon {C)) or point to the file name and
Caontrol-click, and then click Include. An
included file is displayed with a green
icon: &,

To deselect a file, you can either click
the icon again or point to the file name }‘

*

and Control-click, and then click

Nocolard A foldor contsininn coma

4
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Status bar

This area displaysthe date and time of the last backup performed by the system.

Ready Last backup:Jan 23, 2010 4:10:58 PM
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After installing Attix5 Pro Desktop & Laptop Edition ( DL) and creating a Backup Account, you

can tell the Backup Client which files and/or folders to back up and which to ignore by creating a

backup selection( s e e A Se |l #backunpgd dbaeYbaocan)thenstart a backup manually

or schedule automatic backups ( s e erforinlAg a manualbac kup o and fAScheduling a
backupsodo bel ow) .

i) Any changes, additions or deletions to included files and folders will be backed up
intelligently with every manual or scheduled backup.

The following sections describe how to:

Selectdata to back up

Usefilters to specify files and/or folders to be excluded from the backup selection.
Determine the backup selection size

Start backups (automatically and manually)

Cancel a backup

Resume a failedor cancelled backup

You can make your first backup selection or modify a backup selection at any time using the
Backup Selection tab as described below.

To select files and folders for backup:

1. Click the Backup Selection tab.

2. In the Backup Selection tree, navigate to the folder or directory containing the file or
folder.

3. Include or exclude files and/or folders, as described below.

Once a file or folder is included in the backup selection, any modifications to it will
be backed up automatically.
1, | Warning:  If you have limited space on the drive running the Backup Client, it is
recommended that you move the Cache, Logs and Temporary folders as well as the
selection database to another location.

To include an individual file:
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In the Backup Selection tree, navigate to the folder or directory containing the file. In the right -
hand pane, click the file icon (7)) or point to the file name and Control -click, and then
click Include . An included file is displayed with a green icon: ©.

To deselect a file,you can either click the icon again or point to the file name and Control -
click, and then click Deselect . A folder containing some included files is displayed with a green
tinted icon: =,

To include an entire folder:

Point to the folder icon ( L-) and Control-click, and then click Include Folder . Alternatively,
you can select the folder in the Backup Selectiontree, and then click Include Folder on
the Selection menu. Included folders are displayed with a green icon: L=,

i All files in the included folder and its subfolders will be included in the next
backup. Any changes made within this folder or its subfolders will automatically be
included as well.

To deselect a folder:

Point to the folder icon, Control-click, and then click Deselect Folder

To exclude a file or subfolder:

If an entire folder is included but you wish to exclude a particular file or subfolder, point to the

file or folder icon and Control -click, and then click Exclude or Exclude Folder . Excluded
items are displayed with red icons: & or £ Folders that have been included but have some
files or subfolders excluded are green with a red tint: .

You can usefilters to automate file selection based on file types.

Once you have selected allfiles to be included and excluded, it may be useful to
check the size of your backup selection before initiating your first backup. For
more information, see Using Filters later in this chapter.

Some directories (and their contents) are forcefully excluded from the backup
selection. On Mac machines, these are the/dev and /proc directories.
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You can use filters to automate file inclusions or exclusions within a folder, based onfile types.

x A*. pdf filter will include or exclude all PDF files within a folder, as well as
any new PDF files that are added to that folder later.

To apply a predefined filter to a specific folder:

1. Inthe Backup Selectiontree, point to the folder icon and Control -click.

2. Point to Filters .

3. Point to one of the available filters in the list (e.g. MS Office documents ).
4. Click Include or Exclude .

To modify an existing filter

1. In the Backup Selectiontree, point to the folder icon and Control-click, point to Filters ,
and then click Edit filters

2. Select one of the filters andthen modify its properties in the Edit filter  box.

3. Click OK.

To add a new filter from within the Edit filters  dialog box, click the New button,
supply a name that describes the filter, enter the file type(s), and then click OK.

To add a new filter  via the Backup Selection tree:
1. Pointto the folder icon, Control-click, and then click New filter
2. Inthe Filter name box, type a name to be used in the Filters menu
3. Inthe Filter box, specify the file extensionsto which the filter will apply.
4. Click OK.

The filter will be added to the Filters menu and you will be able to use it to include or exclude all
files matching its criteria.

To remove filters from a folder:

1. Pointto the folder icon and Control-click.

2. Pointto Filters .

3. Point to the name of the filter you wish to remove.

4. Clear the check mark next to the selection (nclude or Exclude ).

To identify files and folders selected by filters:

Look at the icon state. Files and flders included in the backup selection by filters display with
icons containing blue check marks: & and (e
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Some inclusions and exclusions are enforced at administration level on the Storage Platform.
This i s c¢ alodl.odmore pnfoonfatiod, see gProfiing i n Chapter 8, AOption
Settings. 0

Files and folders affected by profiling display with the following icons :

File inclusion

W Filtered file inclusion
File exclusion
Folder inclusion

¥ Filtered folder inclusion

Folder exclusion

i) Profiled selections cannot be modified from within the Backup Client and can only be
changed on the Storage Platform. For more information, please refer to the Attix5 Pro
Storage Platform Console User Manual
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Icon legend

On the Backup Selection tab, each file and folder is displayed with an associated icon The
colour of the icon indicates the file or fool der 6s
backup selections, sSeel efict i ng d adardier ihtbis dheptery u p 0

{» ‘& Backup Selection il Restore =] Logs 1
i@ My Computer [ Filename /4 Size Date
- - I_
v [ r-'r-; documents & m 2010-...
b 7 me & .ssh 2009-...
' L& .Trash 2010-...
b [ ssh = Xcode 2010-...
b L Trash |~ AttixSlogs 2005-...
b b Xoode |~ Desktop 2010-...

The following icon legend lists the Attix5 Pro icons and the statuses they indicate. You can
access this legend byclicking Icon Legend on the Help menu.

Note: For more information, see Profiled selectonsi n Chapter 4, iGrap
(GUI ) 0 aimsdn Chhlaypg er -9ns Ad®Pl ug

Icon legend

C File (not selected) The file exists in the folder or directory but is not included in

the backup selection (neither included nor excluded) .

[ Selected by user The Backup Clientuser hasincluded the file in the backup
selection.

g Selected by user filter The Backup Clientuser has applied a filter to the parent folder
or directory. That filter has included the file in the backup
selection.

[=] Excluded by user The Backup Client user hasexcluded the file from being

backed up to the Storage Platform.

[ %] Excluded by administrator The Backup or Storage Platform Administrator has excluded
this file or its file type. Files displaying this icon will not be
backed up to the Storage Platform.

= Included by profiling The Backup or Storage Platform Administrator has included
this file or file type. Files displaying this icon will be backed up
to the Storage Platform and cannot be deselected from within
the Backup Client.

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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Included by profiling filter

Included by profiling

Included by profiling filter

Excluded by profiling

Folder (not selected)

Some files selected by user

All files selected by user

All files selected by user,
some excluded

All files excluded by the
user

Filter applied by user

Filter applied by user,
some excluded

The Backup or Storage Platform Administrator has applied a
filter to the parent folder or directory. That filter has included
the file in the backup selection. Files displaying this icon
cannot be deselectedor excluded from within the Backup
Client.

The Backup or Storage Platform Administrator has included
this file or file type. Files displaying this icon will be backed up
to the Storage Platform and cannot be deselected from within
the Backup Client.

The Backup or Storage Platform Administrator has applied a
filter to the parent folder or directory. That filter has included
the file in the backup selection. Files displaying this icon
cannot be deselectedor excluded from within the Backup
Client.

The Backup or Storage Platform Administrator has excluded
this file or its file type. Files displaying this icon will not be
backed up to the Storage Platform and cannot beincluded in
the backup selectionfrom within the Backup Client.

The folder exists in the directory but it is not included in the
backup selection.

The Backup Clientuser hasincluded some filesin the backup
selection.

The Backup Clientuser hasincluded all files in the backup
selection.

The folder contains no unselected files. Each file is either
included or excluded.

The Backup Clientuser hasexcluded all files in the folder from
being backed up to the Storage Platform.

The Backup Clientuser has applied a filter to the folder. The
filter has included one or more files within the folder.

The Backup Clientuser has applied a filter to the folder that
hasincluded and excluded files within it.



All files included by
profiling

Filter applied by profiling

Filter applied by
profiling , all items
excluded

Filter applied by
profiling, some items
included by user

Filter applied by
profiling, some items
included and some items

excluded by user.

Filter applied by profiling
but items excluded by

user.

Folder excluded by
Global Filter.

All files excluded by
profiling

Plug-in node (not

selected)

Some items selected by
user

All items selected by user

All items selected by user,
some excluded

All items excluded by
user

ATTIX®

The Backup Administrator hasincluded all the files contained in
the folder. All files will be backed up to the Storage Platform.
Theseinclusions cannot be changed by the Backup Clientuser.

The Backup Administrator has applied a filter to the folder. This
filter cannot be removed by a Backup Client user.

The Backup Administrator has applied a filter to the folder,
resulting in the folder being excluded from the backup selection.
This filter cannot be removed by a Backup Clientuser.

The Backup Administrator has applied a filter to this folder
using profiling and some items have been manuallyincluded by
the Backup Clientu s e r

(see NnSelecting ¢

this chapter).

The Backup Administrator has applied a filter to this folder
using profiling. Some items have beerexcluded and others
included by the Backup Clientu s e r NnSel ec

t his

(see

upo earlier in chapter).

Items in the folder have beenincluded using filters (seefUsing

filterso earl i er in this chapter.)

The folder has beenexcluded using Global Filters.

The Backup Administrator has excludedall files in the folder.

Theseexcluded files cannot be included by a Backup Clientuser.

The plug-in exists but is not selected for backup to the Storage
Platform.

The Backup Clientuser has selected some of the items in the
plug-in for backup to the Storage Platform.

The Backup Clientuser has selected all items in the plugin for
backup to the Storage Platform.

The Backup Clientuser hasincluded and excluded items in the
plug-in.

The Backup Client user hasexcluded all items in the plug-in

from being backed up to the Storage Platform.
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lcon legend  continued...

ﬂ Filter applied by user The Backup Clientuser has applied a filter to the plug-in;

specifying that certain file types must be included for backup to
the Storage Platform.

Fa Filter applied by user, The Backup Clientuser has applied a filter to the plug-in;
some excluded specifying that certain file types be included for backup to the
Storage Platform but some items have beenexcluded either
through the use of an exclusion filter or by manual exclusion.

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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It is useful to determine the backup selection size before starting the backup process toavoid
Over Limit errors.

i) The Backup Client compares your backup selection size with the Backup Account
limit (specified by your Backup Administrator) at the beginning of the backup process. If
the selection size exceeds the Account limit,the backup process will stop and an Over
Limit error message will be displayed.

To calculate the backup selection  size:

A. On the File menu, click Calculate Size.
B. Alternatively, click the Size button on the toolbar :

Bachup Restore Find Options Automate Help

The Backup Selection  Size dialog box that appears displays total size of your backup
selection (i.e. all files included for backup).

Backup set index prepared in < 1s
Files and directories: 0 Total size: 0 bytes

1. | Warning:  If your backup selection size exceeds your Account limit, you need to remove
some items from the selection or ask your Backup Administrator to upgrade your
Account limit.

To remove afile from the backup selection

A. In the Size dialog box, pointto f i licend & and Control-click. The icon will turn red to
indicate that it is excluded: &.
To exclude multiple files at once, click a file name in the list, hold down the

Shift key and drag the mouse pointer to highlight the files. Place the mouse
pointer over the selection, Control -click, and then click Exclude .

B. Alternatively, on the Backup Selection tab, deselect or exclude files or folders that are
currently selected for backup. For more information, see Selecting data to back up in
Chapter 5, fABackups. o



ATTIX®

After creating a backup selection, you can exporta list of all backup inclusions and exclusions to
an html file for future reference.

The selection report will specify:
Files and folders included in the backup
Files and folders excluded from the backup
How each item was selected (userselected, filters, profiling or mandatory patching)

Where each item is located on the machine
The total number of items in the backup selection

To export a selection report:

1. Onthe File menu, click Export Selection .
2. Inthe Save As dialog box, select the location in which to save the file, type a file name

in the File name box, and then click Export .

The file will be saved to the specified locationand can be viewed in any Internet browser.



ATTIX®

It is recommended that you run a backup manually after creating your backup selection
to ensure immediate data transmission to the Storage Platform . Thereafter, automatic backups
will ensure hassle-free continuous backups. For more informat i o n, see fASche
b a ¢ k Uapesimthis chapter .

To starta backup manually :
1. Onthe File menu, click Backup Now . Alternatively, click the Backup button on the
toolbar.

Backup

The Backup dialog box appears and displays the progress of the backup:

B O Backup

Backup successfully processed on server
0 minutes 1 seconds total transfer time
Updating local cache

Cleaning up cache

Doing monthly cache cleanup

Cleaning up temporary files

2. To close the Backup Qient after the backup process has started, click theHide button.
This will not cancel the backup process and the Backup Client can be r@pened at any
time to view the progress of the backup.

To view backup logs, click the Logs tab. Backup log dates are displayed in blue.
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Automatic backups are usually enabled and configured during the Account Setup process (see
Step 5 of 7: Schedule Backup Processin Chapter 3 , i Account yoSeah enpblepnd b u t
schedule them at any point in time using the Options and Settings  dialog box.

To schedule daily automatic backups

1. On the Attix5 Pro menu, click Preferences . Alternatively, click the Options button
on the toolbar.

2. Inthe Options and Settings  dialog box, click Backup Schedule

3. Select the Daily Automatic Backups check box and then specify a backup time in
the Back up every day at  box.

4. Click OK.

To schedule advanced backups:

1. On the Attix5 Pro menu, click Preferences .

In the Options and Settings  dialog box, click Backup Schedule

Select theAdvanced Schedule  check box.

In the Week Day box, select a day on which a backup should be initiated.

Specify the time in the Backup time  box.

Click the Add button to add the day and time to the Additional Schedule box.
Repeat steps5 to 7 above until you have added all desired schedules to theAdditional
Schedule box.

No o r~wDdh

You are advised to back up at night when the machine running the Backup Client is
not in use. It must be switched on at the scheduled backup time(s), but the Mac
user does not need to be logged in.

Configuring automatic backups ensures that all selected data is backed up
automatically, without the need for any user interaction. This is a safer alternative

to relying on manual backups.
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Backups will initiate at the scheduled times and the Backup dialog box will appear displaying
the progress of the backup

n_NeNe Backup

Backup successfully processed on server
0 minutes 1 seconds total transfer time
Updating local cache

Cleaning up cache

Doing monthly cache cleanup

Cleaning up temporary files

Tips:
To close the Backup Clientafter the backup process has started, click the Hide button.
This will not cancel the backup process andyou can re-open the Backup Client at any
time to view the progress of the backup.
To view backup logs, dick the Logs tab. Backup log dates are displayed in blue.

i & Backup Selection | @l Restore - =|Logs ]

pEmEL Rl i E R B L | Message: 18:43:20 5at, 23 January 2010 6:43:19 PM - V6.0.0-700 : Ma
23 Jan 2010, 18:33:28 [|Message: 18:43:20 05: Mac 05X, 10.6, i386

- Message: 18:43:20 Preparing selection database

Message: 18:43:20 Initial file set prepared

Backups will be stored on the Storage Platform and accessible via theRestore tab. For more
information on restoring data, see Chapter 6, fARest

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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Cancelling a backup

Once a backup is in progress, you can cancel the process via the Backup progress window or
using the system tray icon.

To cancel a backup:
In the Backup progress window, click the Cancel button.

BNO, Backup - |
Preparing backup

Connecting to service

Starting backup

Initializing secure random generator...

Connecting to Storage Platform on 192.168.20.245:443
Server name: Storage Platform, AttixS Dev A,
Initializing secure random generator...

Connecting to Storage Platform on 192.168.20.245:443
Server name: Storage Platform, AttixS Dev A,
Building selection list

Total selection: 387 bytes in 2 files and folders

Ceancet )| (_tice )

The backup will be cancelled.

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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By default, the Backup Client tries to connect to the Storage Platform four times before
cancelling the backup process. If, however, the previous backup was not successfuland a
manual backup is initiated, the Backup Client will display the prompt: Do you want to
resume the failed backup ... ?0with a 30 second countdown. Click Yes to instruct the Backup
Client to try to continue from where the process fail ed during the previous backup. Click No to
initiate a new backup or Cancel to return to the Backup Client application window .

You can only resume a backup if the backup completed the Processing stage
A new backup will be initiated automatically after the countdown has elapsed.
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On the Restore tab, you can browse a tree structure representation of all successfulbackups
and their files and folders.

How to restore

The following sections describe how to select data to restore, start the restore process, and
search for specific backed up files.

Selecting data to restore

On the Restore tab, the Restore tree givesyou access tobacked up files via two main nodes:
Last Backup and Previous Backups

[ & Backup Selection -~ Restare =| Logs '

o Backups Filename %7 Size Date
¥ | Last Backup {23 Jan 2010, 13:45| 1 backupset.xmi 1 KB 23/01/2010 06:
¥/
B | Users

B vcroace

¥ | Previous Backups

b | 23Jan 2010, 18:45:21
b | 23 Jan 2010, 18:45:05
|~ 23 Jan 2010, 18:44:53
|~ 23 Jan 2010, 18:44:36
|~ 23 Jan 2010, 18:43:16
| 23 Jan 2010, 18:33:26 .

TYYY

The Last Backup node contains the file/folder structure of the last successful backup and
displays the date and time it occurred in parenthesesii (. ) 0

i) | Note: Restores done from the Last Backup node are typically faster than those done
from the Previous Backups node as the Backup Client may be able to retrieve the data
from the cache instead the Storage Platform.

When you expand the Previous Backups node, the Backup Client retrieves the list of previous
backups from the Storage Platform and displays them in the tree.

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.
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To select and restore data  from the

1. Click the Restore tab.

2. Expand the Last Backup node to view the files/folders.

3. Include a single file by clicking the T icon next to the file or by pointing to the file
name, Control-clicking, and then clicking Include . Eachincluded file is displayed with
a green icon;

4. Include an entire folder by pointing to the folder, Control-clicking, and then clicking
Include folder . Eachincluded folder is displayed with a green folder icon: L=,

5. If an entire folder is included but you wish to exclude a particular file or subfolder, point
to the file or folder icon, Control-click, and then click Exclude or Exclude Folder
Excluded items are displayed with red icons: ® or £ Included folders that have some
files or subfolders excluded are green with a red tint: =3

6. Once all the files and folders to be restored are selectedstart the restore process by
clicking Restore on the File menu or the Restore button on the tool bar. For
information on the restore options available, seefiRestoringdatad | at er i n this cha

To select and restore data from

1. Click the Restore tab.

2. Expand the Previous Backups node to connect to the Storage Platform and retrieve a
list of all previous backup dates.

3. Expand the relevant backup node, and then click the folder/directory containing the
data.

4. Include a single file by clicking the icon next to the file or by pointing to the file
name, Control-clicking, and then clicking Include . Each included file is displayed with
a green icon:

5. Include an entire folder by pointing to the folder, Control-clicking, and then clicking
Include folder . Each included folder is displayed with a green folder icon: =,

6. If an entire folder is included but you wish to exclude a particular file or subfolder, point
to the file or folder icon and Control-click, and then click Exclude or Exclude Folder
Excluded items are displayed with red icons: & or £¥ . Included folders that have some
files or subfolders excluded are green with a red tint: .

7. Once all the files and folders to be restored are selected, start the restore process by
clicking Restore on the File menu or the Restore button on the toolbar. For
information on t he r es Restoringdatpobelowns avail able, se

-
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Restoring data

After you have selected the files and folders to restore, you canstart the restore process as
described below.

To start the restore process:
1. On the File menu, click Restore . Alternatively, click the Restore button on the

toolbar:
2%]|2|0 @@

The Restore dialog box will prompt you for a restore location:

Save files in:

O Original locaticn

. i f N
e Folder: | fUsersfattix5/Restore [ Browse |

2. SelectOriginal location to restore the files to the same location that they were backed
up from or selectFolder and then browse to a new location.

/0 | Warning:  If Original location is selected the restored files will overwrite
any existing files with the same name in that location. A warning will, however,
be displayed before the Backup Client overwrites any files.

In the Options area, specify the restore options.

Options

E Recreate directory structure
E Restore empty folders

[ Overwrite files

[] use compression (faster over the Internet)

For more information on restore options,

3. Click OK.

S

e e

t

h e
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Restore options

Recreate directory

structure

Restore empty folders

Overwrite files

Use compression

By default, the folder structure is recreated in the Restore
folder. To specify that all files be restored to one location, clear
the Recreate folder structure check box

l/ Note: If restoring files from different folders with the
same file names, you need to recreate the folder
structure to prevent overwriting the files.

To restore all empty folders within the directory structure,
select theRestore empty folders  check box Clear the
check box to restore only those folders containing backed up
files.

3/ Note: This option is only available when Recreate
directory structure is selected.

Selectthis option to prevent the Backup Client displaying a
prompt before overwriting existing file s.

/v | Warning:  If this check box is selected, files with
matching filenames in matching directories will be
overwritten without warning.

Select theUse compressioncheck boxto enable the Storage
Platform to compress files beforetransmitting them to the
Backup Client.

\J Tip: You are advised to enable this setting when
restoring over a slow Internet connection as it will
reduce the size of the files, making the transfer
process faster.

i) | Note: You can view restore logs on the Logs tab. Restore log dates are displayed in

green.
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Finding files in backups

To find a specific backed up file, it may be easier to use theFind function than to browse the
Restore tree.

You have the option to scan only your last backup (locally), or you can connect to the Storage
Platform and search through previous backups.

To search for afilein  your latest backup:
1. On the File menu, click Find files in backups . Alternatively, click the Find button
on the toolbar:

els Qe @@

Backup Restore Find Options | Automate

2. Type the file name or part thereof in the File name box, and then click Find .

File name (full or partial): ||
B Search last backup (local)

(::,' Search through previous backups (Storage Platform)
Search backup dates

[ ] Limit number of results to: 10

Example : If fs t ait sedrched for, the Backup Client will display a list of all files in the
|l ast backup containing fAstatso in the fil

=

U | Tip: Use the* and ? wildcards for advanced search queries.
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To search for a file in previous backups:

1.

.53' | Tip: Use the* and ? wildcards for advanced search queries.

=
i/
L/

On the File menu, click Find files in
on the toolbar:

ATTIX®

backups . Alternatively, click the Find button

o

Backup

)

Restore

-

Find

Options

©

Automate

Type the file name or part thereof in the File name box.
Select theSearch through previous backup
If you wish to limit the search to particular dates, select the Search backup dates
check boxand then use the Start date and End date boxes to specify a time period.
To limit the number of results that display, select the Limit number of results to

check box and then type a number in the box provided.
Click Find .

2]

Help

s (Storage Platform ) check box.

Note: If Search backup dates is selected the backup date is used for the search

instead of the file create or file modified

date.
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To restore files from the Find Files in Backup dialog box:

1. Inthe search results list, include the files to restore by clicking the icons next to the file
names or by Control -clicking each file name and then clicking Include
2. Click the Restore button.

File name (full or partial): a
G Search last backup (local)

e Search through previous backups (Storage Platform)

@ Search backup dates

Start date: | 01-23-2010 | v | MM-dd-YYYY

End date: | 01-23-2010 u MM-dd-YYYY

[ ] Limit number of results to: 10

| Find )
N S
Search result
Folder Filename Size Date File t... Backup Date

C) fUsersfattix5/.ssh config 1 KB 15/09/2009 11:... 23/01/2010 06:...
& Workspace: backupset.xml 1 KB 23/01/2010 05:... xml 23/01/2010 06:...
& Workspace: backupset.xmil 1 KB 23/01/2010 06:... =ml 23/01/2010 06:...
[ © |Waorkspace: backupset.xmi 1 KB 23/01/2010 06:... xml 23/01/2010 06:...
) Waorkspace: backupset.xmil 1 KB 23/01/2010 06:... =ml 23/01/2010 06:...
) Workspace: backupset.xmil 1 KB 23/01/2010 06:... =ml 23/01/2010 06:...
1 Workspace: backupset.xmi 1KE 23/01/2010 06:... xmil 23/01/2010 06: ...
) Waorkspace: backupset.xmil 1 KB 23/01/2010 06:... =ml 23/01/2010 06:...
| Restore |
N S

( close V) ( Hep )

The Restore Options  dialog box will appear, enabling you to specify the location in which to save
the restored files. For more information on restore c
this chapter.
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Restoring a backup selection

By default, with every backup performed, a copy of the backup selectionis saved on the Storage
Platform . For more information on backup selection, see fiSelecting data to back up earlier in
this chapter.

This enables you to restore, not only your backed up files and folders, but the selection you used
to back them up as well.

i) | Note: This is especially useful in disaster recovery cases, as it enables you to restore
your entire b ackup setup to perform exactly as it did at the last backup.

To restore a backup selection

1. Click the Restore tab.
2. Expand the relevant backup folder, and then click the Workspace node.

[ & Backup Selection -l Restore [=| Logs '

il Backups Filename % Size Date
v [ (23 Jan 2010, 18:45:34) ) backupsetml 1 KB 23/01/2010 06
v 5/
b [ Users

ui]; Workspace

3. Inthe right -hand pane, click the icon next to the name of the backup set to include it for
restore. Include the backupset.xml entry.

Filename 57 Size

& Bxclude
1 Deselect

4. Click the Restore button on the toolbar .

5. Select the appropriate restore options. ( See fASelecting data to resto
chapter.)

6. Click OK.

The backup selectionwill be restored to the location specified in the restore options.

Attix5 Pro V6.2 Copyright © Attix5. All rights reserved.



ATTIX®

Attix5 Pro allows Backup Administrators to archive Backup Clientsb
drive using the Hierarchical Storage Management (HSM) feature. Once data has been archived,
the backups will display in the Restore tree as greyed out folders, allowing you to browse the
file/folder structure of the backups. However, if you try to restore archived data, you may
receive a message informing you that the data has been archived to secondary storage, as

illustrated in the screenshot below.

dat a

to tape

&l Backups
¥ | Last Backup {12 Aug 2010, 10:3

v o

'
'
'
'
'
'

dvyvyvwvyvwvvwvvhl

v

YYYYYYYY

the Restore

!
Ik Workspace

_ Previous Backups

12 Aug 2010, 10:36:57
12 Aug 2010, 10:36:46
12 Aug 2010, 10:36:37
12 Aug 2010, 10:36:15
12 Aug 2010, 10:36:00
12 Aug 2010, 10:35:51
12 Aug 2010, 10:35:41
f
Workspace
12 Aug 2010, 10:35:32
12 Aug 2010, 10:25:40
12 Aug 2010, 10:24:38
12 Aug 2010, 10:21:41
12 Aug 2010, 10:17:40
12 Aug 2010, 10:14:39
12 Aug 2010, 10:13:40
12 Aug 2010, 10:11:22

Grey folders indi cate archived data. However, if you do not see these folders in
tree, it does not mean that no archived backups are available. In such
cases, pease consult your Backup Administrator

backups.

You can access archived data by requesting that your Backup Administratorimport the HSM
data to the Storage Platform. Once the data has beerimported, it will be available for restore in
the same manner as all other backups.

[ i@ Backup Selection 2l Restore =| Logs ]

—
" al )

Filename %7 Size Date

File type

Ei

This data has been archived to secondary storage

and removed from the Storage Platform. To restore any of these files,

please contact your backup administrator and request
to have the files moved back to the Storage Platform.

for further details about archiv ed

or
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